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บทที ่1  
Hozo-Ontology Editor 

1.1 รู้จัก Hozo-Ontology Editor 
โปรแกรม Hozo-Ontology Editor เป็นโปรแกรมท่ีพฒันาข้ึนโดยมหาวทิยาลยัโอซากา (Osaka 

University) ประเทศญ่ีปุ่น เป็นโปรแกรมเคร่ืองมือสนบัสนุนการพฒันาออนโทโลย ี (Ontology Editor) 
ในปัจจุบนัท่ีไดรั้บความนิยม และเป็นเคร่ืองมือถ่ายทอดและจดัเก็บองคค์วามรู้ในรูปแบบของออนโทโลยไีด้
สะดวกและง่ายยิง่ข้ึน 

ออนโทโลย ี คือ การรวมแนวคิดส าคญัท่ีจ  าเป็นในการใชอ้ธิบายเป้าหมายของส่ิงหน่ึง และแสดง
ความสัมพนัธ์ระหวา่งแนวความคิดเหล่านั้น ความสัมพนัธ์ขั้นพื้นฐานท่ีสุด คือ ความสัมพนัธ์แบบทัว่ไป 
หรือ ความสัมพนัธ์แบบจดัเป็น ซ่ึงแสดงค าอธิบายแนวคิดโดยใชล้าเบล (Label) และช่ือล าดบัชั้นดว้ย is-a 

ซ่ึงเป็นความสัมพนัธ์พื้นฐาน (ดั้งเดิม) ท่ีสุด 

1.2  ความต้องการของระบบ(System Requirements) 
ก่อนการติดตั้งโปรแกรม Hozo-Ontology Editor เพื่อใชง้านนั้น ผูใ้ชต้อ้งตรวจสอบคุณสมบติั

เคร่ืองคอมพิวเตอร์ของท่านก่อน เพื่อให้โปรแกรมสามารถท างานบนเคร่ืองคอมพิวเตอร์ของท่าน ไดแ้บบ
เตม็ประสิทธิภาพ โดยมีคุณสมบติัดงั ตาราง 1 

 

ตาราง 1 แสดงคุณสมบัติเคร่ืองคอมพวิเตอร์ 

CPU Intel Pentium III Processor, 800MHz หรือสูงกวา่ 

Ram 256MB หรือสูงกวา่ 

Hard Disk 30MB หรือมากกวา่ 

ความละเอียดของ Monitor 1024x768 (XGA) หรือสูงกวา่ 

OS Windows 2000 (แนะน า Windows XP หรือสูงกวา่), Mac OS X 

JAVA JRE/JDK 1.5.0_10 หรือเวอร์ชัน่สูงกวา่ (แนะน า 1.6.0 หรือสูงกวา่) 

Network 

ไม่จ  าเป็นถา้ใชเ้คร่ืองทอ้งถ่ิน(Local) กรณีมีการใชง้านร่วมกนัภายใน
องคก์ร เครือข่าย ลูกข่ายและเซิร์ฟเวอร์ใหเ้ช่ือมต่อผา่น Ethernet โดย
ใช ้TCP/IP Protocol 
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1.3  การติดตั้ง(Installation) 
การติดตั้งโปรแกรม Hozo-Ontology Editor นั้น จ าเป็นตอ้งมีตวัติดตั้งก่อน โดยสามารถดาวน์

โหลดไดท่ี้ http://www.ei.sanken.osaka-u.ac.jp/hozo/eng/download_en.html   (สมคัรสมาชิกก่อนดาวน์โหลด) 

 

หลงัจากดาวน์โหลดเสร็จเรียบร้อยแลว้ ใหท้  าการแตกไฟล์   โดยการคลิกขวาท่ี
ไฟลแ์ลว้เลือกเมนู Extract to oe52_30en จะไดโ้ฟลเดอร์ข้ึนมาใหม่หน่ึงโฟลเดอร์ ซ่ึงสามารถเรียกใชง้าน
ไดเ้ลยโดยไม่ตอ้งท าการติดตั้ง  

 

                              
รูป 1 แสดงวิธีการแตกไฟล์ 

 

1.4  การเรียกใช้โปรแกรม(Starting the Software) 
หลงัจากไดโ้ฟลเดอร์ของตวัโปรแกรมจากขั้นตอนการติดตั้งขา้งตน้แลว้ ต่อไปเป็นการเรียกใชง้าน 

โปรแกรม Hozo-Ontology Editor โดย 
 เขา้ไปท่ีโฟลเดอร์  ท่ีไดท้  าการแตกไฟลอ์อกมาแลว้ในขั้นตอนการติดตั้ง 
 ดบัเบิ้ลคลิกท่ีไอคอน  จะไดห้นา้ต่างแรกของโปรแกรมดงั รูป 2 แสดงหนา้ต่าง

แรกเม่ือเรียกใชโ้ปรแกรม 

รูป 2 แสดงหน้าต่างแรกเม่ือเรียกใช้โปรแกรม  

ในขั้นตอนน้ีใหผู้ใ้ชก้รอกช่ือ User name
1
 แลว้คลิกปุ่ม OK เพื่อแสดงหนา้ต่างการท างานของ

โปรแกรม Hozo-Ontology Editor   

                                                 
1

 ถ้าผู้ใช้ไม่กรอกช่ือ User name จะไม่สามารถเข้าใช้งานโปรแกรมได้ ตัวอักขระท่ีไม่สามารถใช้ตั้งช่ือ User name ได้ มีดังนี ้“”\ /:? *  < > 

http://www.ei.sanken.osaka-u.ac.jp/hozo/eng/download_en.html
http://www.ei.sanken.osaka-u.ac.jp/hozo/eng/download_en.html
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รูป 3 แสดงหน้าต่างโปรแกรมเม่ือแรกเข้า 

 

1.5  การถอนการติดตั้ง(Uninstall) 
เน่ืองจากโปรแกรม Hozo-Ontology Editor ไม่ไดมี้การติดตั้ง ดงันั้นการถอนการติดตั้งท าไดง่้าย 

โดยการลบโฟลเดอร์ ท่ีไดท้  าการแตกไฟลไ์วทิ้้ง ก็เสร็จส้ินการถอนการติดตั้ง 
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บทที ่2  
องค์ประกอบโปรแกรม Hozo-Ontology Editor 

 

 ในบทน้ี จะแสดงองคป์ระกอบของโปรแกรม Hozo-Ontology Editor ใหผู้ใ้ชไ้ดท้ราบวา่ โปรแกรม
ประกอบไปดว้ยส่วนใดบา้ง และแต่ละส่วนนั้นมีความส าคญัอยา่งไร แสดงภาพรวมของหนา้ต่างโปรแกรม
ใหผู้ใ้ชคุ้น้เคย อธิบายรายละเอียดของเมนูและอธิบายสัญลกัษณ์ต่างๆ ท่ีแสดงในแต่ละส่วนของโปรแกรมวา่
มีความหมายวา่อยา่งไร  

2.1  หน้าหลักของโปรแกรม(Screen Layout) 

 
รูป 4 แสดงองค์ประกอบท้ังหมดของโปรแกรม 

รายละเอียดแต่ละส่วน อธิบายไดด้งัน้ี 
 1. Project Management Pane: ผูใ้ชส้ามารถจดัการโปรเจคทั้งหมด ในรูปแบบของ tree view ได้
ส าหรับทุกๆโปรเจคท่ีผูใ้ชส้ร้างข้ึน โดยมีแถบยอ่ยอยู ่2 แถบ คือ 
  Project   – แสดงและจดัการโปรเจค ในรูปแบบของ Tree View 
  Search   – ใชค้น้หา ออนโทโลย ีในแต่ละโปรเจค   
 2. Browsing Pane: ส่วนแสดงกราฟฟิกของออนโทโลย ี ท่ีผูใ้ชส้ร้างข้ึนทั้งหมด แสดงใหเ้ห็น
ความสัมพนัธ์ทุกๆความสัมพนัธ์ ในรูปแบบกราฟฟิกท่ีดูง่ายและสวยงาม 

1 

4 

3 

2 

7 
6 

5 
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 3. Navigation Pane: ส่วนแสดงภาพรวมของออนโทโลย ี มีทั้งหมด 4 ส่วน โดยแต่ละส่วนจะ
แสดงผลแตกต่างกนัออกไป คือ  
  WC-Tree  – แสดง Concept ทั้งหมดและ Sub level (ความสัมพนัธ์แบบ is-a) 
  RC-Tree  – แสดงความสัมพนัธ์ของ Concept super กบั Sub level  

    (ความสัมพนัธ์แบบ is-a) 
  Map View – แสดงมุมมองของออนโทโลยทีั้งหมด ท่ีอยูใ่น Browsing Pane  

    (บางออนโทโลยมีีปริมาณขอ้มูลสูงมาก ใชพ้ื้นท่ีในการพฒันามาก) 
Search – ส่วนน้ีจะช่วยใหผู้ใ้ชส้ามารถคน้หาและแกไ้ขออนโทโลยไีดง่้ายข้ึน  
                              โดย   สามารถเลือกคน้หาไดต้ามความตอ้งการของผูใ้ช ้ 
                               เช่น คน้หาจาก Link, Player หรือ Value เป็นตน้ 

 4. Definition Pane: แสดงและแกไ้ข Content ต่างๆ ของ node และ slot  
 5. Editing Tool Bar: แถบเคร่ืองมือส าหรับสร้างและแกไ้ขออนโทโลย ี ในแถบเคร่ืองมือน้ีผูใ้ช้
สามารถ เพิ่ม/ลบ node หรือ slot   และเปล่ียนมุมมองการแสดงผลของส่วน Browsing Pane ไดห้ลายรูปแบบ 
 6. Operation Tool Bar: แถบเคร่ืองมือส าหรับจดัการออนโทโลย ี 
 7. Menu Bar: แถบเมนูหลกัของโปรแกรมส าหรับเรียกใชคุ้ณสมบติัต่างๆ  

2.2  ปุ่มค าส่ังการใช้งานโปรแกรม(Tool Bar) 
 Edit Tool Bar 

 
 

  : สร้างโหนด [add node] 

  : สร้างความสัมพนัธ์และเลือกประเภทของความสัมพนัธ์ [add link] 

 : สร้าง a slot (role concept) และเลือกประเภทของ slot [add slot] 

  : ปรับ ยอ่/ขยาย ขนาดของหนา้ต่าง Browsing Pane 

  : เลือกคลาส [select class] 

  : ใส่ axiom [input axiom] 

  : เปล่ียน Browsing Pane เป็นโหมดเดียว [whole view] 

  : เปล่ียน Browsing Pane เป็นโหมดแบ่งหนา้จอตามแนวตั้ง [divide vertical] 

  : เปล่ียน Browsing Pane เป็นโหมดแบ่งหนา้จอตามแนวนอน [divide horizontal] 

  : เปล่ียน Browsing Pane เป็นโหมดการเลือกวตัถุ [select mode] 
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  : เปล่ียน Browsing Pane เป็นโหมดการเคล่ือนยา้ย [move mode] 

  : ปุ่มเลือกวตัถุท่ีถูกเลือกก่อนหนา้ [tracking back] 

  : ปุ่มเลือกวตัถุท่ีถูกเลือกทีหลงั [tracking forward] 
 Operation Tool Bar 

 
 : สร้างโปรเจคหรือออนโทโลยใีหม่ [new] 

 : เปิดออนโทโลยไีฟลจ์ากแฟ้ม [open] 

 : บนัทึกขอ้มูล [save] 

 : บนัทึกขอ้มูลเป็นไฟลช่ื์อใหม่ท่ีต่างจากช่ือเดิม [save as…] 

 : พิมพข์อ้มูลออนโทโลย ี[print…] 

 : แสดงตวัอยา่ง ขอ้มูลออนโทโลย ีส าหรับการพิมพ ์[print preview…] 

 : ตดัวตัถุ [cut] 

 : คดัลอกวตัถุ [copy] 

 : วางวตัถุ [paste] 

 : ลบวตัถุ [delete] 

 : ยอ้นกลบัการกระท า [undo] 

 : ท าซ ้ าการกระท าท่ียอ้นกลบั [redo] 

 : ยอ่หนา้ต่าง Browsing Pane [get small] 

 : ขยายหนา้ต่าง Browsing Pane [get large] 

: เลือกขนาดของ Browsing Pane 

 : เลือกวตัถุท่ีถูกเลือกก่อน [tracking back] 

 : เลือกวตัถุท่ีถูกเลือกทีหลงั [tracking forward] 

 : แสดงหนา้ต่างการจดัการโปรเจค [project view] 

 : แสดงหนา้ต่างการจดัการออนโทโลยบีน OS และเซิฟเวอร์ [browse OS] 

 : แสดงคู่มือการใชง้านโปรแกรม [help] 
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2.3  เมนูการใช้งานโปรแกรม(Menu Bar) 
โปรแกรม Hozo-Ontology Editor มีเมนูการใชง้านของโปรแกรมท่ีเรียกวา่ Menu Bar เป็นเมนูแบบ

เล่ือนลง (pull-down) ซ่ึงแต่ละเมนูจะมีหนา้ท่ีต่างกนัออกไป และมีหลากหลายฟังกช์นั เช่น 
 File: เมนูในการจดัการไฟลท์ั้งหมด 
 Edit: เมนูในการ ปรับแต่ง/แกไ้ข ออนโทโลยี 
 View: เมนูในการจดัการมุมมองของ Browsing pane เป็นตน้ 
ซ่ึงในคู่มือการใชง้านเล่มน้ีจะแสดงเฉพาะเมนูท่ีส าคญัและใชง้านบ่อยเท่านั้น ส่วนเมนูท่ีไม่ไดแ้สดง

ไว ้อยากใหผู้ใ้ชไ้ดท้ดลองใชดู้ เพื่อเพิ่มความช านาญใหก้บัผูใ้ชต่้อไป 
 

 
 File 

 
รูป 5 แสดงเมนู File 

 
 
 

สร้างโปรเจค/ออนโทโลยใีหม่ 

เปิดไฟลท่ี์สร้างไวแ้ลว้ 
บนัทึกขอ้มูลท่ีก าลงัใชง้านอยู ่
บนัทึกขอ้มูลท่ีก าลงัใชง้านอยูเ่ป็นช่ืออ่ืน 
บนัทึกขอ้มูลเป็นนามสกุล .xml 
เปิด Instance Editor 
แสดงไฟลท่ี์ใชง้านล่าสุด 

น าเขา้ไฟลข์อ้มูลชนิดต่างๆ 
ส่งออกไฟลข์อ้มูลเป็นชนิดต่างๆ 

ตั้งค่าต าแหน่งจดัเก็บโปรเจค 
ลบไฟลส์ ารองท่ีบนัทึกไว ้

ตั้งค่าหนา้กระดาษ 
แสดงตวัอยา่งก่อนการพิมพ ์
สั่งพิมพอ์อนโทโลย ี

ปิด Browsing Pane (ออนโทโลย)ี 
ออกจากโปรแกรม(บนัทึกขอ้มูล) 

ออกจากโปรแกรม(ไม่บนัทึกขอ้มูล) 
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 Edit 

 
รูป 6 แสดงเมนู Edit 

 
 
 
 

ยกเลิกการแกไ้ข 
ท าซ ้ าการแกไ้ข 
 

ตดัวตัถุ( Object) ท่ีเลือกไว ้
คดัลอกวตัถุ( Object) ท่ีเลือกไว ้
วางวตัถุ( Object) ท่ีคดัลอกหรือตดัมา 
วาง Slot ในโหนดใดๆ ท่ีเลือกไว ้
ลบวตัถุ(Object) ท่ีเลือก 

เลือกวตัถุ( Object) ทั้งหมดใน Browsing Pane 
เลือกโหนดยอ่ยของโหนดแม่ท่ีเลือกไว ้

ขา้มไปยงั Subclass, super class และ referring  
คน้หา 
แทนท่ีวตัถุ(Object) ท่ีเลือกไว ้
คัน่แต่ละวตัถุเพื่อง่ายต่อการคน้หา/แกไ้ข 

เล่ือนล าดบั Slot ท่ีเลือก ข้ึนไป 1 ต าแหน่ง 
เล่ือนล าดบั Slot ท่ีเลือก ลงไป 1 ต าแหน่ง 

 

เล่ือนไปเลือกวตัถุ(Object) ท่ีท าก่อนหนา้น้ี 
เล่ือนไปเลือกวตัถุ(Object) ท่ีท าตวัถดัไป 
  
พิมพห์รือบนัทึกโหนดท่ีเลือกไวเ้ป็นรูปภาพ 

เพิ่มวตัถุ(Object) ไปยงัโหนดท่ีเลือก 
เล่ือนวตัถุ(Object) ท่ีเลือก 
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 View 

 
รูป 7 แสดงเมนู View 

 Windows  

 
รูป 8 แสดงเมนู windows 

 Diff 

 
รูป 9 แสดงเมนู Diff 

 

เปิดหนา้ต่างออนโทโลยท่ีีเปิดอยูท่ ั้งหมด 

แสดงหนา้ต่างออนโทโลยท่ีีใชง้าน 

เปล่ียนภาษาการใชง้านของโปรแกรม 

ตั้งค่าหนา้จอเป็น Conpact Window 
ปิดหนา้ต่างออนโทโลยท่ีีเปิดอยูท่ ั้งหมด 
ยอ่หนา้ต่างออนโทโลยท่ีีเปิดอยูท่ ั้งหมด 

ลา้งการแสดงการเปล่ียนแปลงทั้งหมด 

ตรวจสอบการเปล่ียนแปลงกบัออนโทโลยอ่ืีน 

แสดง โหนด/โหนดและ Slot 
แสดงผลแบบ  สีเทาทั้งหมด/แบ่งสี 
จดัรูปแบบโหนด(Concept) อตัโนมติั 

เปิดหนา้ต่างแสดง Source code ออนโทโลย ี
แสดงภาษาส ารอง(ภาษาท่ีสอง) 
ก าหนดรายละเอียดท่ีแสดงใน Browsing Pane 
แสดง Pop-up (คลา้ยการคลิกขวาท่ี Browsing Pane) 
แสดงเส้นแบ่งหนา้ใน Browsing Pane 
ก าหนดขนาดขอบภาพ(Map View) 
แสดงวตัถุ(Object) ท่ีเลือกในหนา้ต่างใหม่ 
 แสดงแผนภาพของออนโทโลย ี
 แสดงความสัมพนัธ์ทั้งหมดของออนโทโลยี 
 แสดงสีเส้นความสัมพนัธ์ 
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 Role 

 
รูป 10 แสดงเมนู Role 

 Project 

 
รูป 11 แสดงเมนู Project 

 Help 

 
รูป 12 แสดงเมนู Help 

2.4 ความหมายของไอคอนใน Project Management Pane 
ในส่วน Project Management Pane เม่ือผูใ้ชไ้ดส้ร้างออนโทโลยไีปแลว้จะสังเกตเห็นวา่มีไอคอน

 

แสดงรายละเอียดของโปรเจคท่ีสร้าง 

ปลดล็อคไปรเจคไฟลบ์นเซิฟเวอร์ 

สร้างออนโทโลยใีหม่ 
สร้างโปรเจคใหม่ 

ตั้งค่าการแสดงผลของแถบ Role Concept 

โหลดค่าเร่ิมตน้ของ Role Concept  

แสดงแถบ Role Concept ใน Browsing Pane 

อพัเดทโปรเจคไฟล์ 

ปิด/เปิด โปรเจค 

ดาวน์โหลดโปรเจคไฟลจ์ากเซิฟเวอร์ 
ดาวน์โหลดโปรเจคไฟลจ์าก OS  

 ล็อคโปรเจคไฟลบ์นเซิฟเวอร์ 

ลบ โปรเจค/ออนโทโลย ี

อพัโหลดโปรเจคไฟลบ์น OS 

เปิด โปรเจค/ออนโทโลย ี ท่ีเลือก 

เพิ่มออนโทโลยใีนโปรเจค 

แสดงรายละเอียดเวอร์ชัน่ของโปรแกรม 

เปิดคู่มือการใชง้าน 
เปิดเอกสารอา้งอิง 
เก่ียวกบัตวัช่วย 
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ต่างๆ เกิดข้ึนมากมาย และมีหลายรูปแบบ ผูใ้ชอ้าจจะไม่เขา้ใจความหมายของแต่ละไอคอนวา่หมายถึงอะไร 
แต่ก่อนจะท าความเขา้ใจไอคอนต่างๆ อยากใหผู้ใ้ชไ้ดเ้ปรียบเทียบใหเ้ห็นภาพวา่  

 Project เปรียบไดก้บั folder 
 Ontology เปรียบไดก้บัส่ิงท่ีอยูใ่น folder 
 Concept เปรียบไดก้บัส่ิงท่ีอยูใ่น ontology 
 Slot เป็น Role Concept ท่ีอยูใ่น Concept 

 
 : โฟลเดอร์แม่ท่ีรวมทุกๆ โปรเจคไว ้
 : โฟลเดอร์โปรเจค 

 : ออนโทโลยไีฟล์ 
 : Local project folder 
 : ออนโทโลยท่ีีอพัเดทในเซิฟเวอร์ 

 : ออนโทโลยท่ีีอพัเดทในเซิฟเวอร์แลว้มีการล็อค 
 : ออนโทโลยลี็อคในเซิฟเวอร์ 
 : ออนโทโลยท่ีีสามารถปลดล็อคได ้
 : ออนโทโลยท่ีีอพัเดทใน Local PC 
 : ออนโทโลยท่ีีสามารถปลดล็อคและอพัเดทไดใ้น Local PC 
 : ออนโทโลยท่ีีสามารถล็อคและอพัเดทไดใ้น Local PC 
 : Wholeness Concepts 
 : Relation Concepts 
 : Slot (part-of) 

 : Slot (attribute-of) 
  : Slot (overrided) 

        รูป 13 แสดง Project Management Pane 
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บทที ่3 
การใช้งานโปรแกรม Hozo-Ontology Editor 

  

ในบทท่ีผา่นมา ผูใ้ชไ้ดรู้้องคป์ระกอบและค าสั่งของโปรแกรมไปแลว้ ส าหรับในบทน้ีจะแนะน า
การใชค้  าสั่งการท างานพื้นฐานของโปรแกรม Hozo-Ontology Editor โดยแต่ละค าสั่งผูใ้ชจ้  าเป็นตอ้งรู้ เพื่อ
ใชใ้นการพฒันาออนโทโลยไีดอ้ยา่งถูกตอ้ง    

3.1  การสร้างโปรเจคใหม่ (New Project) 
การสร้างโปรเจคใหม่สามารถท าได ้3 วธีิ ข้ึนอยูก่บัความถนดัของผูใ้ช ้
วิธีท่ี 1: เลือก File > new File… > new Project… > กรอกช่ือ Project > OK > กรอกช่ือ  Ontology > 

คลิกเลือกท่ีช่ือ Project (ท่ีผูใ้ชส้ร้างข้ึน) > New ดงั รูป 14 

 
รูป 14 แสดงวิธีสร้างโปรเจคใหม่พร้อมออนโทโลยี 

หลงัจากท าขั้นตอนขา้งตน้เสร็จ จะไดโ้ปรเจคใหม่ข้ึนมาหน่ึงโปรเจคและในโปรเจคนั้นจะมีหน่ึง 
ออนโทโลย ีดงั รูป 15 
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รูป 15 แสดงโปรเจคและออนโทโลยีท่ีสร้างใหม่ 

 
วิธีท่ี 2: คลิกท่ี    เลือกเมนู Project > new Project…> กรอกช่ือ Project > คลิก 

OK ดงั รูป 16 

 
รูป 16  แสดงการสร้างโปรเจคใหม่โดยการเลือกเมนู Project 
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รูป 17 แสดงผลลพัธ์จากการสร้างโปรเจคโดยการเลือกเมนู Project 

 

วิธีท่ี 3: คลิกขวาท่ี  > new Project …> กรอกช่ือ Project > OK ดงั รูป 18

 
รูป 18 การสร้างโปรเจคโดยการคลิกขวาท่ี Local Storage  
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รูป 19 แสดงผลลพัธ์จากการสร้างโปรเจคโดยการคลิกขวาท่ี Local Storage 

3.2  การสร้างออนโทโลยใีหม่ (New Ontology) 
จากขั้นตอนการสร้างโปรเจคใหม่ ถา้ผูใ้ชส้ังเกตุดูจะเห็นวา่เฉพาะ วิธีท่ี 1 เท่านั้นท่ีเม่ือสร้างโปรเจค

แลว้จะมีออนโทโลยมีาใหพ้ร้อม ส่วนในวิธีท่ี 2 และ 3 จะไม่มีการสร้างออนโทโลยีมาให ้ ผูใ้ชต้อ้งท าการ
สร้างออนโทโลยเีองภายหลงั ซ่ึงมีวธีิการสร้าง 2 วธีิ ดงัน้ี 

วิธีท่ี 1: คลิกขวาท่ีโปรเจค > new Ontology… > กรอกช่ือ Ontology > OK ดงั รูป 20 

รูป 20  แสดงการสร้างออนโทโลยีโดยการคลิกขวาท่ีโปรเจค 
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รูป 21 แสดงผลลพัธ์การสร้างออนโทโลยีโดยการคลิกขวาท่ีโปรเจค 

วิธีท่ี 2: คลิก 1 คร้ังท่ีโปรเจค > เลือกเมนู Project > new Ontology… > กรอกช่ือ Ontology >     
คลิก OK ดงั รูป 22 

 
รูป 22 แสดงการสร้างออนโทโลยีใหม่โดยการเลือกเมนู Project 
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รูป 23 แสดงผลลพัธ์จากการสร้างออนโทโลยีโดยการเลือกเมนู Project 

3.3  การเพิม่โหนด (Add Node)  
 คลิกท่ี  หน่ึงคร้ัง จะไดโ้หนดเพิ่มหน่ึงโหนด ซ่ึงผูใ้ชส้ามารถเปล่ียนช่ือของโหนดได ้
เช่น   เม่ือเปล่ียนช่ือแลว้คลิกท่ีปุ่ม add Node จะไดผ้ลดงั รูป 24 

                
รูป 24 แสดงการเพ่ิมโหนดโดยการคลิกท่ีปุ่ม add node 

 หรือผูใ้ชจ้ะสร้างโหนดดว้ยการคลิกขวาในส่วนของ Browsing Pane (ส่วนแสดงกราฟฟิก) 
แลว้เลือกท่ี add Node ก็จะไดโ้หนดใหม่เช่นเดียวกบัการคลิกท่ีปุ่ม  น้ี ดงั รูป 25 

          
รูป 25 แสดงการเพ่ิมโหนดโดยการคลิกขาวท่ี Browsing Pane 
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ผูใ้ชส้ามารถเปล่ียนช่ือโหนด (Concept) ไดท่ี้ลาเบล label ในส่วนของ Definition Pane 

 
รูป 26 แสดงการแก้ไขรายละเอียดของโหนดในส่วนของ Definition Pane 

 ในการสร้างโหนด (Concept) ถา้ผูใ้ชต้อ้งการให้โหนดท่ีสร้างข้ึนใหม่ เป็นโหนดท่ีมี
ความสัมพนัธ์กบัโหนดอ่ืน (Super node) ใหผู้ใ้ชเ้ลือกท่ีโหนด (Concept) ท่ีผูใ้ชต้อ้งการใหเ้ป็นโหนดแม่ 
(Super Node) แลว้คลิกขวาเลือก add Node จะไดโ้หนดท่ีมีความสัมพนัธ์กนั รูป 27 

 
รูป 27 แสดงการสร้างโหนดลกู (Sub node) โดยการคลิกขวาท่ีโหนดแม่ (Super Node) 

 

 หากมีโหนด(Concept) ท่ีสร้างไวโ้ดยไม่มีความสัมพนัธ์ใดๆ และผูใ้ชต้อ้งการให้โหนดนั้นๆมี
ความสัมพนัธ์เป็นแบบ is-a สามารถท าไดโ้ดยการคลิกท่ีโหนดท่ีจะใหเ้ป็นโหนดแม่ (Supper Node) ก่อน 
และกดปุ่ม Shift ท่ีคียบ์อร์ดคา้งไวแ้ลว้กดท่ีโหนดท่ีตอ้งการใหเ้ป็นโหนดลูก (Sub Node) แลว้กดท่ีปุ่ม 
add Link จะไดค้วามสัมพนัธ์แบบ is-a 

Label “Node Name”ไดถู้ก
ปรับเปล่ียน 

ส่วน Definition Pane 

Sub Node 
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รูป 28 แสดงการสร้างโหนดลกู (sup node) โดยการกดปุ่ม Add Link 

 หรือท าไดโ้ดยการคลิกขวา เลือกท่ี add Link หลงัจากท่ีไดท้  าการเลือกโหนด(Concept)ทั้ง
สองเรียบร้อยแลว้ 

 
รูป 29  แสดงการสร้างความสัมพันธ์โดยการคลิกขวา 

3.4  การเพิม่ Slot (Add Slot) 
 การเพิ่ม Slot ผูใ้ชจ้  าเป็นจะตอ้งคลิกเพื่อเลือกโหนด (Concept) ก่อน แลว้จึงท าการเพิ่ม Slot 
การเพิ่ม Slot ท าไดโ้ดย คลิกท่ีโหนดท่ีตอ้งการเพิ่ม Slot แลว้คลิกเลือกประเภทของ Slot ท่ีผูใ้ชต้อ้งการ 
จากนั้นคลิกท่ีปุ่ม add Slot ดงั รูป 30 

               
 รูป 30  แสดงวิธีการเพ่ิม slot ให้กับโหนดโดยการคลิกปุ่ม add slot 

 
 

2.กดปุ่ม add Slot 

คลิกปุ่ม Add Link เพื่อสร้าง
ความสมัพนัธ์แบบ is-a 

Sub Node Sub Node 1.คลิกเลือกโหนด 
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 หรือผูใ้ชจ้ะสร้างโดยการคลิกขวาท่ีโหนดท่ีตอ้งการเพิ่ม Slot แลว้เลือก add Slot เลือกประเภท
ของ Slot ท่ีผูใ้ชต้อ้งการ ก็จะได ้Slot เพิ่มมาเช่นเดียวกบัการคลิกท่ีปุ่ม add Slot ดงั รูป 31 

     
รูป 31 แสดงวิธีการเพ่ิม Slot ให้กับโหนดโดยการคลิกขวาท่ีโหนด (Concept) 

 รายละเอียดของ Slot และ Concept สามารถเปล่ียนแปลงรายละเอียดไดใ้นส่วนของ Definition 
Pane การเปล่ียนแปลงจะท าไดเ้ม่ือผูใ้ชไ้ดท้  าการคลิกเลือกท่ีโหนด (Concept) หรือวา่ Slot แลว้เท่านั้น ส่ิงท่ี
สามารถท าการปรับเปล่ียนแกไ้ขได ้ประกอบไปดว้ย 
  -Role concept    -Class constraint 
  -Role holder    -Class (part-of, attribute-of) 

-Quantity constraint (cardinality)  -Constraint value 

 
 
 
 
 
 

รูป 32 แสดง Definition Pane ส าหรับแก้ไขรายละเอียดของ โหนด (Concept) และ Slot 

เม่ือคลิกท่ีโหนด 

(Concept) 

เม่ือคลิกท่ี Slot 

Sub Node 
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3.5  การลบวตัถุ (Deleting Object) 
 สามารถลบวตัถุ(Object) ไดโ้ดยการคลิกเลือก โหนด (Concept), Slot หรือ ความสัมพนัธ์ แลว้คลิก
ขวาเลือกค าสั่ง [Delete]  
 หรือใชปุ่้ม Delete บนแถบ Menu Bar, Ontology Operation Tool Bar หรือ Editing Tool Bar ก็ได ้
ถา้ผูใ้ชต้อ้งการลบหลายวตัถุ (Object) พร้อมๆกนั ใหผู้ใ้ชก้ดปุ่ม Shift ท่ีคียบ์อร์ดคา้งไว ้ แลว้คลิกเลือกวตัถุ 
(Object) ท่ีตอ้งการลบ แลว้คลิกขวาเลือกค าสั่ง [Delete]  

 
รูป 33 แสดงการลบวัตถ ุ(Deleting Object) 

3.6  การบันทกึไฟล์ (Save File) 
 Save 
 การบนัทึกไฟลท่ี์ก าลงัเปิดท างานอยูท่  าดงัน้ี 

 เลือก File > save  (จาก Menu Bar) 
 Save As… 
 ค าสั่ง Save as… เป็นการบนัทึกไฟลท่ี์ก าลงัใชง้านอยูใ่หเ้ป็นช่ืออ่ืน เพื่อสะดวกในการแกไ้ข ขณะท่ี
ไฟลช่ื์อเดิมก็ยงัคงอยูเ่ช่นเดิมไม่มีการเปล่ียนแปลงใดๆ ท าไดด้งัน้ี 

 เลือก File > save as… 
 โปรแกรมจะแสดง  selection dialog  ใหก้รอกช่ือไฟล ์แลว้คลิกปุ่ม save ดงั รูป 34 
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รูป 34 แสดงการใช้ค าส่ัง Save as… 

3.7  การเปิดไฟล์ (Loading Ontology) 

3.7.1  การเปิดไฟล์ออนโทโลยจีาก [Project Tab] 
 เลือก File > Open File…ในแถบเมนูเพื่อแสดงหนา้ต่าง "Open Ontology" 

 
รูป 35 แสดงการเปิดไฟลอ์อนโทโลย ี(Loading Ontology) ประเภท .ont 
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 เลือก ออนโทโลย ี ท่ีแสดงจากโฟลเดอร์โปรเจค บนแถบ [Project] คลิกปุ่ม [Open] เพื่อเปิด
หนา้ต่างการแกไ้ขและแสดงออนโทโลย ี
 ออนโทโลย ีสามารถแสดงผลในหนา้ต่างแยกต่างหาก  โดยคลิกท่ีปุ่ม [Browse] แต่ออนโทโลยี
ท่ีเปิดจะสามารถดูไดเ้ท่านั้น (แกไ้ขไม่ได)้ 

3.7.2  การเปิดไฟล์ออนโทโลยจีาก [File Tab] 
 เลือก File > Open File…ในแถบเมนูเพื่อแสดงหนา้ต่าง "Open Ontology" 
 เลือกแถบ [File] เพื่อดูรายการออนโทโลย ี(Default)  
 เลือก ออนโทโลย ีท่ีแสดงจากไฟล ์บนแถบ [File] คลิกปุ่ม [Open] เพื่อเปิดหนา้ต่าง

การแกไ้ขและแสดงออนโทโลย ี

 
รูป 36 แสดงไฟล์ออนโทโลยี (Loading Ontology) ประเภท .xml 

 ออนโทโลย ีสามารถแสดงผลในหนา้ต่างแยกต่างหาก โดยคลิกท่ีปุ่ม [Browse] แต่ออนโทโลยี
ท่ีเปิดจะสามารถดูไดเ้ท่านั้น (แกไ้ขไม่ได)้ 
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รูปที ่3.26: หน้าต่างไฟล์ออนโทโลยีท่ีเปิดโดยกดปุ่ม [Browse]  

3.8  การปรับขนาด Browsing Pane (Zoom in/out) 
การปรับขนาดของ Browsing Pane สามารถปรับไดโ้ดยเลือกท่ีปุ่มปรับขนาด [combo box] บน 

Ontology Operation Tool Bar หรือบน Editing Tool Bar 

 
รูป 37 การปรับขนาด Browsing Pane 

การคลิกท่ีปุ่ม [▲] [▼] ทางดา้นซา้ยของช่องเลือกปรับขนาดบน Ontology Operation Tool Bar
จะง่ายต่อการปรับขนาดของ Browsing Pane  
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3.9  แสดง Concept map [Map View] 
 แถบ [Map View] ในส่วนของ Navigation Pane จะแสดงภาพขนาดยอ่ของออนโทโลยี ท่ีเปิดใชง้าน
อยูใ่น Browsing Pane โดยจะแสดงภาพท่ีอยูภ่ายในกรอบส่ีเหล่ียมสีแดง เม่ือผูใ้ชเ้ล่ือนกรอบสีแดงไปท่ีใด
ภาพท่ีแสดงใน Browsing Pane จะเล่ือนตามไปดว้ย 
 นอกจากนั้น เม่ือผูใ้ชส้ลบัการใชง้านระหวา่ง Wholeness Concepts กบั Relation Concepts ส่วนของ
Map View ก็จะสลบัดว้ย 

 
รูป 38 แสดง Map View 

3.10 การ Import ออนโทโลยไีฟล์ 
โปรแกรม Hozo-Ontology Editor เป็นโปรแกรมท่ีมีความสามารถในการ import ไฟลไ์ด ้ เพื่อท่ีจะ

ท าการแกไ้ขไฟลน์ั้นๆ และสามารถ import ไฟลไ์ดห้ลายประเภท (Hierarchical Text, CSV Text, Hozo 
Text, OWL) มีขั้นตอนดงัน้ี 

 เลือกเมนู File >import…>เลือกประเภทไฟล์>เลือกไฟล>์open ดงั รูป 39 
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รูป 39 แสดงวธีิ Import ไฟล ์

 
รูป 40 แสดงการเลือกไฟล์ชนิด OWL ส าหรับใช้ import  
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3.11  การ Export ออนโทโลยไีฟล์ 
 การ Export 2ไฟลโ์ปรเจคของผูใ้ช ้โปรแกรม Hozo-Ontology Editor สามารถ Export ไฟลไ์ดห้ลาย
ชนิด ข้ึนอยูก่บัเวอร์ชัน่ของโปรแกรมท่ีผูใ้ชไ้ดท้  าการดาวน์โหลดมา เช่น Text/HTML, CSV, RDF, OWL, 
DAML+OIL เป็นตน้ มีขั้นตอนในการ Export ดงัน้ี 

 เลือกเมนู File >Export…>เลือกประเภทไฟลท่ี์ตอ้งการ Export>save to file>save  

 
รูป 41 แสดงวิธี Export ไฟล์  

 
รูป 42 แสดงหน้าต่างการ Save ไฟล์ท่ี export 

                                                 
2
 ไฟล์ท่ีผู้ใช้ export  จะอยู่ท่ี Folder ช่ือ export (Folder path:*\oe52_30en\data3\Export) 
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3.12 การพมิพ์ออนโทโลย ี(Printing Ontology) 
 เลือก File > print preview จาก Menu Bar หรือคลิกท่ีปุ่ม print preview จาก Ontology 

Operation Tool Bar เพื่อเปิดหนา้ต่าง ดูตวัอยา่งก่อนการพิมพ ์ดงั รูป 43 เม่ือตั้งค่าเสร็จคลิก
ปุ่ม Print… 

 
รูป 43 หน้าต่าง ดูตัวอย่างก่อนพิมพ์ (Print preview) 

การตั้งค่าการพิมพใ์นหนา้ต่าง Print Preview Dialog ผูใ้ชส้ามารถก าหนดได ้ดงัน้ี 
  -เลือกยนืยนัการพิมพ ์   -ก าหนดขนาด(Scale) การพิมพต่์อหน่ึงหนา้กระดาษ 
  -เลือกการพิมพ ์  หวักระดาษ/ทา้ยกระดาษ -และก าหนดขนาดของกระดาษท่ีใชพ้ิมพ ์
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3.13 การจัดการเมื่อมีการเลอืก Object ของออนโทโลยี 

3.13.1 การย้ายต าแหน่งไปที่ Defined concept 
เม่ือผูใ้ชค้ลิกท่ี Properties ของออนโทโลยใีดๆใน Browsing Pane โปรแกรมจะยา้ยต าแหน่ง

เมา้ส์ไปท่ี Define Concept ใหโ้ดยอตัโนมติั 

 
 

 
รูป 44 แสดง Define concept เม่ือคลิกเม้าส์ท่ี properties 

 

 

 

 

 

 

 

 

 

 

 

 

คลิก Properties 

แสดง Define Concept 
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3.13.2 การ Tracking 
 ปุ่ม Tracking เป็นเสมือนปุ่มบนัทึกงานท างานชนิดหน่ึง ท่ีจดจ าการท างานของผูใ้ชบ้น Browsing 
Pane วา่ท างานท่ีส่วนใดบา้ง หรือมีการคลิกเมา้ส์แต่ละคร้ังท่ีส่วนใดบา้ง โปรแกรมจะท าการบนัทึกไว ้ เพื่อ
สะดวกในการยอ้นกลบัเม่ือผูใ้ชต้อ้งท างานกบัออนโทโลยท่ีีมีขนาดใหญ่ ปุ่ม tracking มีใหเ้ลือกใชไ้ดท่ี้ 
Menu Bar, Operation Tool Bar และ Editing Bar 

 
รูป 45 แสดงการเรียกใช้ค าส่ัง Tracking  
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3.13.3 การเลือ่นหน้าจอแสดงผลด้วยเม้าส์ 
 การเล่ือนหนา้จอแสดงผลออนโทโลย(ีBrowsing Pane) ดว้ยเมา้ส์ท าได ้2 วธีิ 
  1.เล่ือนดว้ยลอ้เล่ือนของเมา้ส์(ตรงกลาง) เม่ือหมุนลอ้เล่ือนของเมา้ส์หนา้จอแสดงผลจะ
เล่ือนข้ึนและลง ถา้ตอ้งการใหเ้ล่ือนไปดา้นซา้ยหรือขวาใหก้ดปุ่ม CTRL ท่ีคียบ์อร์ดคา้งไวพ้ร้อมกบัการ
หมุนลอ้เล่ือนของเมา้ส์ 
  2.เล่ือนดว้ยการลากเมา้ส์  โดยคลิกปุ่ม [Move Mode] บนแถบ Operations Tool Bar ตวัช้ี
เมา้ส์จะเปล่ียนเป็นรูปมือ ซ่ึงสามารถท าการลากเมา้ส์เพื่อเล่ือนหนา้จอการแสดงผลได ้ และเม่ือตอ้งการให้
เมา้ส์กลบัเป็นแบบเดิมใหก้ดท่ีปุ่ม [Select Mode] เมา้ส์จะกลายเป็นแบบเลือก Object ดงัเดิม 
 

 
รูป 46 แสดงปุ่มการเปล่ียนเม้าส์ให้สามารถลากได้หรือเลือกวัตถ ุ(Object) ได้ 

 
 

Select Mode และ 

Move Mode 

เมา้ส์เปล่ียนเป็นรูปมือเม่ือ
คลิกปุ่ม Move Mode 
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3.14  การจัดรูปแบบออนโทโลยี 

3.14.1 รูปแบบ Vertical/Horizontal  
ใหผู้ใ้ชเ้ลือกท่ีโหนด(Concept) ท่ีตอ้งการปรับรูปแบบ  
 คลิกเลือก View > Layout > Vertical Layout หรือ Horizontal Layout ท่ี Menu Bar เพื่อ

จดัรูปแบบของ sup concept ในลกัษณะของพีระมิด (ล าดบัชั้น) 

 
รูป 47 แสดงรูปแบบ Vertical Layout 

 

 
รูป 48 แสดงรูปแบบ Horizontal Layout 
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3.14.2 รูปแบบ Automatic layout 
 คลิกเลือก View > Layout > Automatic Layout ท่ี Menu Bar  

เพื่อจดัรูปแบบของ Sup concept ในลกัษณะของปิระมิต (ล าดบัชั้น) โดยจะเรียงจากบนลงล่าง และ
จากซา้ยไปขวา และเม่ือผูใ้ชย้กเลิกการจดัรูปแบบอตัโนมติั โปรแกรมจะถามวา่ตอ้งการเก็บรูปแบบการจดั
แบบอตัโนมติัไวห้รือไม่ ถา้ผูใ้ชก้ด yes โปรแกรมจะคงรูปแบบ แบบอตัโนมติัใหด้งัเดิม  

 

 
รูป 49 แสดงรูปแบบ Automatic Layout 
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3.14.3 ก าหนดขนาดพืน้ทีส่ าหรับเขียนออนโทโลยี  
 การพฒันาออนโทโลย ี ในบางสาขา บางแขนง ออนโทโลยมีีขนาดใหญ่มาก ผูใ้ชส้ามารถท่ีจะ
ก าหนดพื้นท่ีในการเขียนออนโทโลยไีดภ้ายหลงัจากท่ีไดเ้ขียนออนโทโลยไีปแลว้ โดย 

 เลือก  View > Canvas Size Setting  จาก Menu Bar  
เพื่อเปิดหนา้ต่างก าหนดค่าพื้นท่ี ซ่ึงจะใหผู้ใ้ชร้ะบุขนาดเป็นความกวา้งและความยาวของพื้นท่ี 

 
รูป 50 แสดงการก าหนดขนาดพืน้ท่ีการเขียนออนโทโลยี 

3.15  การเปลีย่นภาษา (Language) 
 โปรแกรม Hozo-Ontology Editor บางเวอร์ชัน่ สามารถใชง้านไดม้ากกวา่ 1 ภาษา การเปล่ียนภาษา
ท่ีใชง้านท าไดไ้ม่ยาก โดย 

 เลือก Window > Language…>เลือกภาษาท่ีตอ้งการ ท่ี Menu Bar 
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รูป 51 แสดงวิธีเปล่ียนภาษาของโปรแกรม 
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บทที ่4  
การพฒันาออนโทโลยเีบือ้งต้น (อย่างง่าย) 

  

 ในบทน้ี เป็นตวัอยา่งในการพฒันาออนโทโลย ี โดยจะแบ่งเน้ือหาออกเป็นส่วนๆ ตั้งแต่เร่ิมตน้การ
พฒันาจนถึงการพฒันาท่ีเสร็จสมบูรณ์ วา่มีขั้นตอนอะไรบา้ง โดยยกตวัอยา่งการพฒันาออนโทโลยสี าหรับ
รถยนตม์าใหผู้ใ้ชไ้ดท้  าความเขา้ใจ และทดลองท าตามทีละขั้นตอนเพื่อใหเ้กิดความเขา้ใจมากข้ึน  

4.1  ตัวอย่างการพฒันาออนโทโลยรีถยนต์ 

4.1.1 ก าหนดสาขา และ ขอบเขต 
 ออนโทโลยท่ีีสร้างข้ึนจะครอบคลุมเน้ือหาในสาขาใด ? 

-เช่น รถยนต,์ ขา้ว, กลว้ยไม ้ฯลฯ 

 ออนโทโลยน้ีีจะน าไปใชง้านอะไร (วตัถุประสงค)์ ?  
-สนบัสนุนการส่งออก, เพาะปลูก, ควบคุมคุณภาพ, จ าหน่าย ฯลฯ 

 ออนโทโลยน้ีีช่วยตอบค าถามอะไร ?  
-รถยนตมี์ลกัษณะอยา่งไร, รถยนตป์ระกอบดว้ยอะไรบา้ง ฯลฯ 

4.1.2 ก าหนดมโนทัศน์ (Concept) 
 มโนทศัน์(Concept) เป็นกลุ่มของส่ิงท่ีมีคุณสมบติัเหมือนๆกนั 

 ก าหนดมโนทศัน์ท่ีส าคญัในสาขาท่ีเราสนใจ เช่น สนใจรถยนตก์ าหนดไดด้งัน้ี 

-รถยนต ์

-รถเก๋ง 

-รถกระบะ 

-รถตู ้
-รถแวน 

-รถ SUV 

- ฯลฯ 

4.1.3 ความสัมพนัธ์ของมโนทัศน์แบบ”จัดเป็น” (is-a) 
 ก าหนดความสัมพนัธ์ของมโนทศัน์แบบ “จดัเป็น” (is-a) 

 ตวัอยา่งความสัมพนัธ์ระหวา่งมโนทศัน์แบบ “จดัเป็น” (is-a)  เช่น 

-รถเก๋ง  จดัเป็น  รถยนต ์

-รถกระบะ จดัเป็น  รถยนต ์
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-กลว้ย  จดัเป็น  ผลไม ้

-กลว้ยน ้าวา้ จดัเป็น   กลว้ย 

 

 ความสัมพนัธ์แบบ “จดัเป็น” (is-a) 

 
รูป 52 แสดงรูปแบบความสัมพันธ์แบบจัดเป็น is-a 

4.1.4 คุณสมบัติของมโนทัศน์ (Property) 
 คุณสมบติัของมโนทศัน์ เช่น 

-รถยนต ์มีส่วนประกอบ คือ ลอ้, พวงมาลยั, กระจกขา้ง, ท่อไอเสีย, ไฟหนา้-หลงั เป็นตน้ 

-ไวน์ มีคุณสมบติั คือ สี, เปอร์เซ็นของแอลกอฮอล์, ผูผ้ลิต เป็นตน้ 

 ประเภทของคุณสมบติั 

-คุณสมบติัท่ีมีมาแต่ก าเนิด(Intrinsic) เช่น ลอ้ และ พวงมาลยัของรถยนต ์

-คุณสมบติัท่ีไดม้าภายหลงั(Extrinsic) เช่น สี, ช่ือ และ ราคาของรถยนต ์

 การสืบทอดคุณสมบติัของมโนทศัน์ เช่น 

-หาก “รถยนต”์ ประกอบไปดว้ย ลอ้ และพวงมาลยั ดงันั้น “รถกระบะ” จะตอ้งมี ลอ้ และ
พวงมาลยั ดว้ยเช่นกนั เน่ืองจาก “รถกระบะ” จดัเป็น “รถยนต”์ ชนิดหน่ึง 
-หาก “ไวน”์ มีคุณสมบติัคือ สี และ กล่ิน “ไวน์แดง” ก็ตอ้งมีคุณสมบติั คือ สี และ กล่ินดว้ย 
เน่ืองจาก “ไวน์แดง” จดัเป็น “ไวน์” ชนิดหน่ึง 

 ตวัอยา่งคุณสมบติั(Property) ของมโนทศัน์  
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-ความสัมพนัธ์แบบ part-of 

 
รูป 53 แสดงความสัมพันธ์แบบ part-of 

-ความสัมพนัธ์แบบ Attribute-of 

 
รูป 54 แสดงความสัมพันธ์แบบ attribute-of 

4.1.5 ตัวอย่างเพิม่ความเข้าใจ(ออนโทโลยีรถยนต์) 
 รถยนต ์มีหลายประเภท เช่น รถยนต,์ รถเก๋ง, รถกระบะ, รถตู,้ รถแวน, รถ SUV  

(เป็นการก าหนดมโนทศัน์(Concept) ท่ีส าคญัในสาขาท่ีเราสนใจ) 
 รถยนต ์มีส่วนประกอบ คือ ลอ้, พวงมาลยั, กระจกขา้ง, ท่อไอเสีย, ไฟหนา้-หลงั เบาะนัง่ 

(เป็นการก าหนดคุณสมบติั(Property) ใหก้บัมโนทศัน์ 
 
 
 
 
 
 
 
 

 

*ข้อมลูแบบตัวเลขหรือข้อความ 
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 แผนภาพแสดงควาสัมพนัธ์มโนทศัน์(Concept) 

 
รูป 55 แสดงแผนภาพความสัมพันธ์ของ Concept 

 

 แผนภาพแสดงคุณสมบติั(Property) ของมโนทศัน์ 

 
รูป 56 แสดงแผนภาพคุณสมบัติ (property) ของมโนทัศน์ 
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 แผนภาพรวม 

 
รูป 57 แสดงแผนภาพรวมของมโนทัศน์ออนโทโลยี 

4.1.6 เขียนออนโทโลยด้ีวย Hozo-Ontology Editor 
 (1) เปิดโปรแกรม Hozo-Ontology Editor 

 เขา้ไปท่ีโฟลเดอร์  ท่ีไดท้  าการแตกไฟลอ์อกมาแลว้ในขั้นตอนการติดตั้ง 
 ดบัเบิ้ลคลิกท่ีไอคอน  จะไดห้นา้ต่างแรกของโปรแกรมดงั รูป 58 

รูป 58 แสดงหน้าต่างแรก (Initial Settings) เม่ือเรียกใช้โปรแกรม 
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ใหผู้ใ้ชก้รอกช่ือ User name3  แลว้ คลิกปุ่ม OK เพื่อแสดงหนา้ต่างการท างานของโปรแกรม    
Hozo-Ontology Editor   

 
รูป 59 แสดงหน้าต่างโปรแกรม Hozo-Ontology Editor 

 

(2) สร้างโปรเจคใหม่ 

 เลือก File > new File… > new Project… > กรอกช่ือ Project > OK  

 กรอกช่ือ   Ontology > คลิกเลือกท่ีช่ือ Project (ท่ีผูใ้ชส้ร้างข้ึน) > New ดงั รูป 60 
 

                                                 
3

 ถ้าผู้ใช้ไม่กรอกช่ือ User name จะไม่สามารถเข้าใช้งานโปรแกรมได้ ตัวอักขระท่ีไม่สามารถใช้ตั้งช่ือ User name ได้ มีดังนี ้“”\ /:? * < > 
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รูป 60 แสดงวิธีสร้างโปรเจคใหม่พร้อมออนโทโลยี 

หลงัจากท าขั้นตอนขา้งตน้เสร็จ จะไดโ้ปรเจคใหม่ข้ึนมาหน่ึงโปรเจคและในโปรเจคนั้นจะมีหน่ึง 
ออนโทโลย ีดงั รูป 61 

 

 
รูป 61 แสดงโปรเจคและออนโทโลยีท่ีสร้างใหม่ 

 

 

 

 

 

โปรเจคและออนโทโลย ี   
ท่ีสร้างข้ึนใหม่ 
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(3) เร่ิมพฒันาออนโทโลยี 
 ดบัเบิ้ลคลิกท่ี Ontology ท่ีตอ้งการท างาน จะมีกล่องโตต้อบเปิดข้ึนมาท่ีกลางหนา้จอ ถาม

ผูใ้ชว้า่ตอ้งการสร้าง any concept หรือไม่? ใหผู้ใ้ชค้ลิกปุ่ม Yes เพื่อสร้างโหนด Any 
concept ข้ึนมา 1 โหนด ดงั รูป 62 

 
รูป 62 แสดงกล่องโต้ตอบ ส าหรับการสร้าง any concept 

 
รูป 63 แสดง any concept ท่ีสร้างขึน้ 

 
 
 
 

ดบัเบิ้ลคลิกท่ีออนโทโลย ี

ท่ีตอ้งการท างาน 
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 การเพิ่มโหนด เพิ่มโดยการคลิกขวาท่ีโหนดท่ีตอ้งการเพิ่มแลว้เลือก add Node หรือ คลิกท่ีปุ่ม 
 (add Node)ซ่ึงจะไดค้วามสัมพนัธ์เป็นแบบจดัเป็น (is-a) 

 
รูป 64 แสดงวิธีการสร้างโหนด (Concept) เพ่ิม 

 การแกไ้ขช่ือและขอ้มูลต่างๆ ของโหนด สามารถแกไ้ขไดท่ี้ส่วนของ  Definition Pane 

 
รูป 65 แสดงส่วนแก้ไขรายละเอียดโหนด (Definition Pane) 

 
 
 

 

ส่วน Definition pane 
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 การเพิ่ม slot   ท าไดโ้ดยคลิกขวาท่ีโหนดท่ีตอ้งการเพิ่ม Slot แลว้เลือกประเภทของ Slot ท่ี
ตอ้งการเพิ่ม หรือ คลิกท่ีปุ่ม  (add Slot) แลว้เลือกประเภทของ Slot ท่ีตอ้งการ 
 (ในตวัอยา่ง เลือกเป็น part-of)  

 
รูป 66 แสดงวิธีการสร้าง Slot เพ่ิม 

 การแกไ้ขช่ือและขอ้มูลต่างๆ ของ Slot สามารถแกไ้ขไดท่ี้ส่วนของ  Definition Pane  

 
 
 

ส่วน Definition pane 

 

Slot ท่ีสร้างข้ึน 
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 จะสังเกตุเห็นวา่ Slot ท่ีสร้างข้ึนนั้นยงัเป็นสีเหลืองอ่อนอยู ่เป็นเพราะยงัไม่ไดมี้กาสร้างโหนด 
(Concept) มารองรับ  

 
รูป 67 แสดง Slot ท่ียังไม่มีการสร้างโหนด (Concept) มารองรับ 

 สร้างโหนด(Concept) มารองรับ Slot ท่ียงัเป็นสีเหลืองอ่อนอยู ่ จะสังเกตุเห็นวา่ Slot ช่ือ “ลอ้”  
ท่ีถูกสร้างโหนด(Concept) มารองรับแลว้จะเปล่ียนเป็นสีเหลืองเขม้ 

 
รูป 68 แสดง Slot “ล้อ” เป็นสีเหลืองเข้ม ท่ีได้สร้างโหนดรองรับแล้ว  
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 ผลลพัธ์ท่ีไดห้ลงัจากสร้าง Ontology เสร็จ 

 
รูป 69 แสดงออนโทโลยีรถยนต์ท่ีสร้างเสร็จสมบูรณ์แล้ว 
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บทที ่5  
ฟังก์ช่ัน/ค าส่ัง การใช้งานที่น่าสนใจ 

 

 ในบทน้ี  จะแนะน า ค  าสั่ง/ฟังกช์ัน่ การใชง้านท่ีน่าสนใจ ท่ีจะช่วยใหก้ารพฒันาออนโทโลยกีระท า
ไดง่้ายข้ึน    เช่น การแสดงภาพรวมออนโทโลย ี ,การคน้หาออนโทโลย,ี การเปรียบเทียบออนโทโลย ี และ
การน าทาง(Navigation) ไปยงั Super Node/Sub Node   เป็นตน้  

5.1  Show map 
1. เปิดออนโทโลย ี ท่ีผูใ้ชต้อ้งการให ้ show map (ออนโทโลยตีวัอยา่ง travelling.ont) โดยการ

ดบัเบิ้ลคลิกท่ีออนโทโลยท่ีีตอ้งการ 

 
รูป 70 แสดงวิธีเปิดออนโทโลยีเพ่ือ show map 

2. เลือกโหนด(Concept) ท่ีตอ้งการใหเ้ป็นจุดโฟกสั (focal point) แลว้คลิกขวาเลือกไปท่ี show 
Map… (ในตวัอยา่งเลือกท่ีโหนด Any)  

ดบัเบิ้ลคลิก ออนโทโลย ี
ท่ีตอ้งการเปิด 
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 รูป 71 แสดงโฟกัสโหนด (Focal point) 

3. เลือกส่ิงท่ีผูใ้ชต้อ้งการให้แสดงจาก Map Option Input Dialog  

 
รูป 72 แสดงหน้าต่าง Show map และหน้าต่าง Map Option Input Dialog  

 
 
 

 

โหนด(Focal point)  

ส่วนการตั้งค่าการแสดงผล 

หนา้ต่างส าหรับเลือกส่ิงท่ีตอ้งการแสดง  
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5.2 Differential (เปรียบเทียบ)  
1. เปิดออนโทโลยไีฟล ์ ท่ีตอ้งการเปรียบเทียบ                                                                           

(เป็นออนโทโลยีตัวเดียวกับท่ีผู้ใช้ได้ท าการแก้ไขแล้วและบันทึกต่างช่ือจากไฟล์เดิม) 

 
รูป 73 แสดงวิธีเปิดออนโทโลยีไฟล์ (Travelling_NEW.ont) 

2. ท่ี Menu Bar เลือก Diff > check difference...> เลือกออนโทโลยไีฟลท่ี์ตอ้งการน ามา
เปรียบเทียบ จาก selection dialog >คลิก open  

 
รูป 74 แสดงวิธีเปิดออนโทโลยีไฟล์ส าหรับเปรียบเทียบจากเมนู Diff 

ตัวอย่าง: เลือกไฟล ์travelling_NEW.ont 
ซ่ึงเป็นไฟลท่ี์แกไ้ขจาก travelling.ont 
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3. หลงัจากเลือกไฟลจ์าก selection dialog แลว้คลิก open  หนา้ต่าง Update of Ontology จะแสดง
ข้ึนใหผู้ใ้ชเ้ลือกประเภทการเปรียบเทียบ(check by IDหรือ check by LABEL)แลว้คลิกปุ่ม OK 

 
รูป 75 หน้าต่าง update of ontology 

4. จะมีหนา้ต่างแสดงรายการการแกไ้ขแสดงข้ึน และในส่วน browsing pane จะมีสัญลกัษณ์ก ากบั
ไวว้า่เกิดการเปล่ียนแปลงท่ีใดบา้ง  เม่ือผูใ้ชเ้ลือกในรายการการแกไ้ข (List of Changes) 
โปรแกรมจะแสดงต าแหน่งนั้นๆใน Browsing pane ใหอ้ตัโนมติั 

 
รูป 76 แสดงหน้าต่าง List of Change และสัญลกัษณ์การเปล่ียนแปลงใน Browsing Pane 

ความหมายของไอคอนท่ีแสดงใน Browsing Pane 
  ไอคอนแสดงวา่มีการเพิ่มวตัถุ(Object) เขา้มาใหม่  
 ไอคอนแสดงวา่วตัถุ(Object) มีการเปล่ียนแปลง 

 ไอคอนแสดงวา่วตัถุ(Object) นั้นถูกลบทิ้ง 
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5. คลิกขวาท่ีวตัถุ(object)เพื่อเลือกค าสั่ง  ยนืยนั/ยกเลิก การเปล่ียนแปลงออนโทโลยี โดยเลือกท่ี   
-Accept เพื่อยอมรับการเปล่ีนแปลง 
-Refuse เพื่อยกเลิกการเปล่ียนแปลง 

 
รูป 77 แสดงวิธีเลือกการ ยอมรับ/ยกเลิก การเปล่ียนแปลง 

6. ยกเลิกหนา้จอแสดงการเปล่ียนแปลง คลิก Diff >clear checks 

 
 

รูป 78 แสดงภาพก่อนและหลงัใช้ค าส่ัง Clear Checksใน Browsing Pane 

เม่ือสัง่ Clear Checks สญัลกัษณ์จะหาย 
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5.3 Ontology search 
 แถบ คน้หา [Search] ในส่วน Navigation Pane เม่ือป้อนขอ้ความและก าหนดเกณฑก์ารคน้หา แลว้
ผูใ้ชค้ลิกปุ่มคน้หา [Search] ผลการคน้หาจะแสดงในตารางในส่วนล่างของแทบ็ 
 ท่ีตารางผลการคน้หา ถา้ผูใ้ชค้ลิกท่ีรายการท่ีแสดง ในส่วนของ Browsing Pane จะแสดงต าแหน่ง
นั้นๆ ดว้ย ซ่ึงง่ายต่อการคน้หา  

 
รูป 79 แสดง Tab [Search] และต าแหน่งผลการค้นหา 

 

 และในการคน้หาน้ี จะตอ้งเป็นออนโทโลยท่ีีก าลงัท าการเปิดการแกไ้ขอยูเ่ท่านั้น ส่ิงท่ีโปรแกรม
สามารถท าการคน้หาได ้ ประกอบไปดว้ย 

  -Basic Concept, class 
-Role Concept, slot 
-Role Holder 
-Class constraint (Player) 
-และ Value  

 
 

 
 
 

Tab [Search] ท่ีอยูใ่นส่วนของ 
 Navigation Pane 

ผลการคน้หา 
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5.4  Navigation Support 
ในบางคร้ังการสร้างออนโทโลยกี็อาจจะมีโครงสร้างออนโทโลยท่ีีใหญ่มากจน Browsing Pane ไม่

สามารถแสดงออกทางหนา้จอไดท้ั้งหมดเลยทีเดียว ซ่ึงยากต่อการคน้หาโหนด (concept) ท่ีตอ้งการ ดงันั้น 
Hozo-Ontology Editor จึงไดพ้ฒันา Navigation Support ข้ึนมาเพื่อความง่ายและเพื่อความสะดวกต่อผูใ้ชใ้น
การคน้หาหรือบ่งช้ีเส้นทางความสัมพนัธ์ของแต่ละ concept เม่ือโครงสร้างออนโทโลยมีีขนาดใหญ่มากๆ 

5.4.1  แสดงไฮไลท์ความสัมพนัธ์ (Highlight display) 
Hozo-Ontology Editor จะท าการไฮไลทส่์วนท่ีมีความสัมพนัธ์ต่อกนัเม่ือ concept หรือ slot ถูกเลือก 

โปรแกรมจะท าการไฮไลทส่์วนท่ีมีความสัมพนัธ์ต่อกนั โดยส่วนท่ีเป็น super concept (ความสัมพนัธ์แบบ 
is-a) จะถูกไฮไลทด์ว้ยเส้นสีเขียว และส่วน sub concept จะถูกไฮไลทด์ว้ยเส้นสีฟ้า ท าใหง่้ายต่อการคน้หา 
supper concept หรือ sub concept ของโหนดท่ีเลือกไว ้

 
รูป 80 แสดงไฮไลท์เส้นความสัมพันธ์ 

5.4.2  การข้ามไปยงั Supper Node (Jump to Super) 
 เม่ือผูใ้ชส้ร้างออนโทโลยข้ึีนมาแลว้ และโครงสร้างของออนโทโลยมีีขนาดใหญ่และซบัซอ้นมาก 
ในบางคร้ังการคน้หา Super concept ของโหนดท่ีเราสนใจก็เป็นไปไดย้าก ดงันั้นการใชเ้ทคนิค [Jump to 
Super] จึงช่วยอ านวยความสะดวกใหก้บัผูใ้ชไ้ดม้าก  

เม่ือผูใ้ชต้อ้งการคน้หา Super concept ของโหนด (concept) ท่ีสนใจโดยใชเ้ทคนิค [Jump to Super] 
สามารถท าไดโ้ดย 

 คลิกขวาท่ีโหนดท่ีสนใจ> Jump > Jump to super  
เม่ือท าตามขั้นตอนขา้งตน้แลว้ Super concept จะถูกเลือกแทนโหนด (concept) ท่ีสนใจในตอนแรก 

จะเห็นไดว้า่ไม่ตอ้งเสียเวลาคน้หาใหยุ้ง่ยาก 

Sub concept แสดงดว้ยเสน้สีฟ้า 

Super concept แสดงดว้ยเสน้สีเขียว 
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รูป 81 แสดงการใช้ค าส่ัง jump to Super 

5.4.3  การข้ามไปยงั Sub Node [Jump to Sub] 
เช่นเดียวกนักบั [Jump to Super] เพื่อความสะดวกกบัผูใ้ชใ้นการคน้หา sub concept ในกรณีท่ี

โครงสร้างออนโทโลยมีีขนาดใหญ่ แต่จะแตกต่างจาก [Jump to Super] ตรงท่ี โหนดหน่ึงโหนด อาจจะมี 
sub concept ไดม้ากกวา่หน่ึง ดงันั้นการใชง้านจึงแตกต่างกนัเล็กนอ้ย โดยการ [Jump to Sub] ท าไดด้งัน้ี  

 คลิกขวาท่ีโหนด (concept) ท่ีเราสนใจ > Jump > Jump to Sub 
  จะมีหนา้ต่างรายการ sub concepts ทั้งหมดของโหนด(concept) นั้น > เลือก sub concept ท่ี

เราตอ้งการคน้หา > คลิก OK  
เม่ือท าตามขั้นตอนขา้งตน้แลว้ Sub concept จะถูกเลือกแทน super concept ในกรณีท่ีเราตอ้งการ

คน้หา sub Slot (sub Properties) ของ Slot ท่ีสนใจก็สามารถท าไดด้ว้ยวธีิเดียวกนักบัการคน้หา concept 
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รูป 82 แสดงการใช้ค าส่ัง jump to Sub 
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5.4.4  การข้ามไปที ่Concept อ้างองิ (Move to reference concept) 
 Reference concept คือ slot ท่ีมีความสัมพนัธ์กบั concept ซ่ึงหน่ึง concept อาจจะมีหลาย reference 
concept ดงันั้นการคน้หาจึงเป็นไปไดย้าก ผูพ้ฒันาโปรแกรม Hozo-Ontology Editor จึงไดพ้ฒันาเทคนิคการ
ยา้ยไปเลือก concept อา้งอิง (Move to reference concept) ข้ึนมาเพื่อความสะดวกของผูใ้ชง้าน มีวธีิดงัน้ี 

 คลิกขวาท่ีโหนดท่ีสนใจ > Jump > Jump to referring…  
 จะแสดงหนา้ต่างรายการ reference concept ทั้งหมด>เลือก reference concept ท่ีตอ้งการ >

คลิกปุ่ม OK  
 

 
 

 
รูป 83 แสดงการใช้ค าส่ัง Move to reference concept 
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5.5  การก าหนดเคร่ืองหมายคั่น (Setting Bookmarks) 
การตั้งค่า Bookmark เป็นอีกรูปแบบหน่ึงท่ีช่วยใหผู้ใ้ชส้ะดวกและง่ายต่อการคน้หาและแกไ้ขขอ้มูล

ในออนโทโลย ีในกรณีท่ีออนโทโลยมีีขนาดใหญ่ 

5.5.1  การก าหนดเคร่ืองหมายคั่น (Setting Bookmarks) 
 เคร่ืองหมายคัน่(Bookmark) สามารถเพิ่มลงใน concept node หรือ slot ได ้โดยการคลิกขวาท่ีโหนด
หรือ Slot ท่ีตอ้งการก าหนดเคร่ืองหมายคัน่ แลว้เลือก [set Bookmark…] จะเห็นวา่มีเคร่ืองหมายรูปธงสีแดง
ติดอยูท่ี่ concept หรือ slot ท่ีเลือก เพื่อแสดงใหท้ราบวา่ไดท้  าการก าหนดเคร่ืองหมายคัน่ไวแ้ลว้ 
 

 
 

 
รูป 84 แสดงวิธีก าหนด bookmark ของ Concept 

  

ธงสีแดงแสดงการ 
Set Bookmark แลว้ 
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5.5.2  การข้ามไปยงัเคร่ืองหมายคั่น (Jump to Bookmarks) 
 ในบางคร้ังเราอาจจะก าหนดเคร่ืองหมายคัน่ไวจ้  านวนมาก ท าใหห้าเคร่ืองหมายคัน่นั้นไม่เจอ ดงันั้น
การใชเ้ทคนิค Jump to Bookmarks จึงตอ้งใชค้วบคู่กบัการ setting Bookmark เพื่อใหง่้ายต่อการคน้หาและ
แกไ้ข 
 การขา้มไปยงัเคร่ืองหมายคัน่ (Jump to Bookmarks) นั้นสามารถท าไดโ้ดย คลิกขวาท่ีพื้นท่ีวา่งใน 
Browsing Pane เลือกเมนู [jump Bookmark…] จะแสดงหนา้ต่างรายการ Bookmark ท่ีไดก้  าหนด
เคร่ืองหมายคัน่ทั้งหมดข้ึนมาแสดง ใหค้ลิกหน่ึงคร้ังเลือกวตัถุ (Object) ท่ีตอ้งการขา้มไป แลว้คลิกปุ่ม [OK] 
จะเห็นไดว้า่วตัถุ (Object) ท่ีเราเลือกในหนา้ต่างรายการนั้นจะถูกเลือกใน Browsing Pane 
 

 
รูป 85 แสดงวิธี Jump to bookmark 
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5.5.3  การลบเคร่ืองหมายคั่น (Removing Bookmarks) 
การลบเคร่ืองหมายคัน่สามารถท าได ้2 วธีิ คือ 

1. การลบเคร่ืองหมายคัน่ออกทีละวตัถุ (Object) 
 คลิกขวาท่ีวตัถุ (Object) ท่ีมีเคร่ืองหมายคัน่อยูเ่ลือกเมนู [unset Bookmarks…] 

 

 
 

 
 
 
 
 
 
 
 

รูป 86 แสดงวิธียกเลิกการก าหนด Bookmark 
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2. การลบเคร่ืองหมายคัน่ทั้งหมดในคร้ังเดียว 
 คลิกขวาท่ีพื้นท่ีวา่งใน Browsing Pane เลือกเมนู [clear Bookmarks…] จะแสดง

หนา้ต่างถามผูใ้ชว้า่ตอ้งการลบเคร่ืองหมายคัน่ (Bookmark) ทั้งหมดหรือไม่? ถา้
ตอ้งการใหล้บทั้งหมด ใหค้ลิกปุ่ม [Yes]  

 
รูป 87 แสดงวิธียกเลิกการก าหนด Bookmark ท้ังหมดในคร้ังเดียว 
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จดัท าโดย 

ห้องปฏิบัติการวจัิยเทคโนโลยภีาษาธรรมชาติและความหมาย 

ศูนย์เทคโนโลยอีเิลก็ทรอนิกส์และคอมพวิเตอร์แห่งชาติ  

http://www.nectec.or.th/ 

 

ติดต่อสอบถาม 

ดร.เทพชยั ทรัพยนิ์ธิ  
Email: thepchai.sup@nectec.or.th 

ดร.มารุต บูรณรัช  
Email: marut.bur@nectec.or.th 
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